
Announce™ 1.2.7
A simple network utility for sending instant messages and audio to other users.

• Send the same message to many users. • Supports multiple zones.
• Save groups of users. • Audio/voice messages!
• Send several different messages at the same time. • Simple.

Distributed as Shareware by:
Tad Woods, T&T Software, P.O. Box 1210, Salem, VA 24153
70312,3552 on CompuServe, Tad Woods on America Online
tandtsw@roanoke.infi.net on Internet
540/389-0764 fax (24 hours)
540/389-0889 voice (10AM-5PM EST and as someone is available)

Announce User and Announcer (a system extension) are fully-functional Shareware. You may
install the programs on up to ten Macintoshes for up to 30 days. After 30 days you must 
purchase an unlimited users license or remove the programs from all Macintoshes in your 
building.

If you purchase an unlimited users license you will receive a disk containing the most recent 
versions of Announce User, Announce Administrator, and Announcer. In addition to sending 
messages, the Administrator application has the added abilities to Set Clocks, Restart, and 
Shut Down. The “welcome” screen does not appear each time you open the licensed version
of Announce.

One unlimited users license covers an unlimited number of zones and users for one business
in one building. You must purchase an additional license for each business and/or building. 
One unlimited users license is $39.00 (U.S.). For convenience, print the following order form:



Announce Order Form
Mail to: T&T Software, P.O. Box 1210, Salem, VA 24153. Please send U.S. funds only. Overseas orders 
add $2.00 for shipping. Tax-payer ID furnished upon request. You may also fax questions and orders to 
540-389-0764.

Send the latest version of Announce User, Announce Administrator, and 
Announcer on disk.

Number of unlimited user licenses: ______
(One license covers unlimited zones and users for one company in one building.)

Price is $39.00 per license. Total amount enclosed: ______

__Check, cash, or money order

__Purchase order   P.O.#___________________

__Visa __MasterCard 
Card #_______________________   Exp. Date _______
Cardholder’s name______________________________
Cardholder’s signature___________________________

Your Name:
Company Name:

Address:
City, State, Zip:

Country:
Comments:



What is Announce?
Announce User (or Announce Administrator)

An application that sends messages.
Copy the application to your hard drive. Open it to send a message.
Copy Announce User for the majority of Mac users on the network.
Copy Announce Admin only for network administrators.

Announcer
A System Extension/Control Panel Device that receives messages.
Copy Announcer into the System Folder or Control Panels folder.
Make sure AppleTalk is Active in the Chooser, and a valid Chooser name (System 6) or

Owner name (System 7 Sharing Setup control panel) is set up.
Restart the Mac to enable receiving messages.
Copy Announcer to every Mac on the network that will receive messages.
Important! If you are upgrading from version 1.0 or 1.1 remove the old Announcer 
extension from the System Folder or Extensions folder.

How to Send a Message
1. Start Announce User or Announce Admin. 
2. A window titled Announcement will appear. If no window appears, select New 

Announcement from the File menu. You may open many Announcement 
windows at the same time.

3. Select a Zone. Only one zone may be selected, however you may open additional 
Announcement windows to select additional zones. If there is only one zone, the
default zone * is automatically selected.

4. Select one or more Users who will receive your message. User’s names that 
remain highlighted will receive your message. Select your own name if you wish
to receive a “carbon copy.”

5. Type a Message. The message will automatically be tagged with your name and 
the time of day.

6. If you wish the receiving users’ Macs to “beep” just before the message appears, 
check the box Play Alert Sound.

7. If you wish to add voice or sound that will play as each user acknowledges the 
message, check the box Add Audio....
See How to Add Audio on the next page.

8. Press the Send button.
9. The status “Delivered” appears by each name to verify that your message is 

displayed on that Mac. Each user will see your message and press OK.
10. You know that a user has pressed OK when the status “Acknowledged” appears by 

that user’s name. Leave the window open if you wish to monitor 
acknowledgments. Select New Announcement from the File menu to send a new
message while you monitor an old message. 



How to Add Audio
To add audio to a message, click the Add Audio... box at the bottom of the 

Announcement window. A dialog box appears. Audio can then be added from 
one of two sources: a microphone or a sound embedded as a 'snd ' resource in a
file.

If your Mac has a built-in microphone, or you have added the necessary 
MacRecorder™ hardware and software (a Macromedia product), you can press 
Record from built-in microphone....

Or you can select a pre-recorded sound from the pop-up menu. To add additional 
sounds to this menu press Use a 'snd ' resource... and select a file that contains 
'snd ' resources. If you have pre-recorded sounds that are saved in formats 
other than 'snd ' resources, you may be able to use software such as 
SoundEdit™ (part of the MacRecorder package) to re-save sounds in the 
necessary 'snd ' resource format.

Size indicates how much memory the audio requires. You want to keep audio 
messages small to minimize the amount of network traffic and the time it takes 
to deliver an audio message.

Press Play to test play the sound you recorded or selected.
The Volume menu sets the audio volume on both your Mac and the receiving Mac. 1 

is the quietest.

Cancel Pending Messages
Sometimes you may want to remove from users’ Macs a message that has been 

“Delivered” but not yet “Acknowledged.” Press Cancel to take the message off 
of those users’ screens. Messages canceled this way will not be logged (see 
How to Configure the Announcer Control Panel).

Sound When Acknowledged
If this option is “checked” the alert sound will play each time a user “acknowledges” 

the message.

Poll Zone for More Users
Often on a slow and/or large network all user names will not appear at first. Use this 

option to immediately search the selected zone for more users.

Save & Save As...
Saves the contents of the active Announcement window, including the selected zone,

users, message, and any added audio. Use this option to save groups of users. 



How to Configure the Announcer Control Panel
You may configure basic options dealing with receiving messages. Open Control 

Panels and double-click the Announcer icon in System 7, or select the 
Announcer icon in the System 6 Control Panel.

Check boxes indicate which Announcer features are enabled/disabled. Initially most 
features are enabled.

Log Messages to File* saves incoming messages to a text file named Announcer Log 
in the System 7 Preferences folder, or the System 6 System Folder. View the log 
with TeachText or any word processor. To view the most recent log entries, close 
and re-open the file. For convenience, use the System 7.x Finder to make an 
Alias to the log file. The log file remains “locked” in the Finder. Therefore to clear
and reduce the size of the log file, press clear in the Announcer Control Panel.

Message Queue Size determines the maximum number of unacknowledged 
messages the Mac will “hold.” 

Remove Msg After determines the amount of time an unacknowledged message will 
remain on the screen before it is automatically removed. Normally messages 
remain on the screen until they are acknowledged or canceled, but 
administrators may want to use this feature because pending messages may 
block some scheduled processes from running. If the Log Messages to File 
option is on, messages will be logged when they are automatically removed.

Network Name selects either the Owner Name or the Macintosh Name, as defined in 
the Sharing Setup Control Panel, to be used as the Announcer network name 
(System 7.x only).

Restart the Mac for changes to Announcer’s settings to take effect. 

Additional Features in Announce Admin  istrator  
Announce Administrator is provided with the unlimited user license.
WARNING: The additional features provided by the Announce Admin application 

should be used with caution. Only give network administrators copies of this 
application.

NOTE: Users can individually disable these features from the Announcer Control 
Panel.

Set Clocks... is useful for synchronizing every Mac’s clock to the same time, such as 
after Daylight Savings Time.

Restart...* is useful for remotely restarting a Mac after remotely installing new 
software that requires a Restart. WARNING: Any unsaved data on the restarted 
Mac will be lost.

Shut Down...* is useful for remotely turning off a Mac. WARNING: Any unsaved data 
on the shut down Mac will be lost.

* This feature is initially disabled and must be enabled from the Announcer Control Panel 
before it will work.



How Announce Works & Tips
For compatibility and reliability Announcer uses Apple’s Notification Manager to 

display messages.
The Announcer Control Panel is highly efficient. It requires only 8.5K to 13K of System

Heap RAM (depending on the Message Queue Size), and never consumes CPU 
cycles “polling.” Announcer allocates temporary memory for audio as needed.

Announcer will queue up delivered and un-acknowledged messages until the 
Message Queue is full. Additional messages will replace one of the pending 
messages if at least one of those messages does not contain audio.

Announcer installs code at startup. If Announcer is unable to install due to an error, 
the message “Announcer not installed” followed by an error code appears. 
Possible errors include:
-00028AppleTalk is not active in the Chooser.
-01027Duplicate network name. Do all of your Macs have unique

Owner Names in Sharing Setup or the Chooser? Are there 
two copies of Announcer in the System Folder?

If you receive a message that may contain audio, but you do not wish to hear the 
audio immediately, hold option as you press OK or return to acknowledge the 
message. The audio will not play and the message will re-appear in 10 minutes.

Administrators who do not wish users to have the capability to add audio to 
messages, may easily create a version of Announce User without the Add Audio 
button. Use Apple’s ResEdit program to edit the 'STNG' resource in Announce 
User. Change the Audio Quality setting to four blank spaces, then Announce 
User will not display an Add Audio button.



Error Messages
Normally the messages “Delivered” and “Acknowledged” appear beside user names 

after sending a message. Some other messages that might appear include the 
following.

“USER NOT FOUND ON NET” The user’s Mac is not responding. That user’s Mac might
be off or asleep (if it’s a Powerbook).

“TIME OUT - NO RESPONSE” The user’s Mac is not responding. Possibly the network is
very busy.

“UNSUPPORTED VERSION” The version of your Announce User or Announce Admin 
program is incompatible with the user’s responding Announcer version.

“UNSUPPORTED REQUEST” The responding version of Announcer does not support 
the request.

“USER DISABLED OPTION” User disabled the option in the Announcer Control Panel.
“MESSAGE QUEUE FULL” User has too many unacknowledged messages.
“NOT CANCELED” You are trying to cancel a message that is in the process of being 

acknowledged.
“OLD NET NAME OR ADDRESS” The user name no longer matches the user name at 

that network address. Open a New Announcement and look for the user under a
new name or in another zone.

“REMOTE ERROR - TIME OUT” An audio message was not delivered in time. When 
sending an audio message to multiple users, avoid sending a copy to yourself.

Announcer installs, but nothing appears on the network
After the Announcer Control Panel is installed, and if no error message appears from 
Announcer after the Restart process, this Macintosh should appear to other users 
from the Announce User program. If it does not appear try the following:
Make sure only one copy of Announcer is installed on this computer.
Make sure both a Macintosh and Owner name are set in the System 7.x Sharing 

Setup Control Panel, or a User Name is set in the System 6.x Chooser.
It may be possible that Announcer loads too early during the Restart process. 

Rename the Annoucer Control Panel to ZAnnouncer, and Restart.
Select Poll Zone for More Users from the Announce menu in the Announce User 

program.



Disclaimer
T&T Software has spent a great deal of time ensuring the reliability of this product. 
However, T&T Software will not be responsible for any damage or loss cause by the 
use of this software. If you have comments regarding Announce please contact T&T 
Software at the address given in this document.

Version History
1.2.7 - December 1995. The Announce User, Announce Administrator, and Announcer
control panel now better handle on-the-fly network connection changes.
1.2.6 - June 1995. The Announce User and Announce Admin programs now work 
properly on a Powerbook after Sleep (the Announcer Control Panel already handles 
Sleep properly). The ability of these programs to locate Macs whose network 
addresses changed is also improved (e.g. Powerbooks’ addresses can change after 
sleep). The Announcer Control Panel’s version number was updated but otherwise did
not change.
1.2.5 - May 1995. The sorting of Zone and Users lists in the Announce User and 
Announce Admin programs is no longer case sensitive. The Announcer Control Panel’s
version number was updated but otherwise did not change.
1.2.4 - March 1995. Added a Network Name option to the Announcer Control Panel. 
You can now select either the Owner Name or the Macintosh Name to be used as the 
Announcer network name. Fixed a bug in Announce User and Announce Admin that 
sometimes prevented typing or pasting up to the maximum number of characters in 
the send message box.
1.2.3 - January 1995. The number of zone names that can fit in the zone lists of the 
Announce User and Announce Admin programs is increased. Fixed a bug in the 
Announcer Control Panel that could cause Powerbooks to freeze when coming out of 
sleep. Updated T&T Software’s mailing addresses.
1.2.2 - April 1994. Added a Volume Limit menu to Announcer Control Panel. Audio 
messages play at the lower of the volumes selected by the sender or this volume 
limit.
1.2.1 - February 1994. Added log file option for incoming messages in the Announcer 
Control Panel. Announce User and Announce Admin did not change and remain at 
version 1.2.
1.2 - October 1993. Add Audio... added. Select All Users added to the Edit menu. 
Sound When Acknowledged added to the Announce menu. Shut Down feature added 
to Announce Admin. The Message Box now exactly matches the dimensions of the 
received message dialog. Announcer gets re-enabled on Powerbooks after Sleep. 
Announcer is now a Control Panel with user selectable options. Other minor 
enhancements. Version 1.2 is fully network compatible with version 1.1.
1.1 - Minor update to Announce User and Admin fixed a problem with the applications
on 68000 based Macs. No change to the Announcer INIT; only the version number 
changed for consistency with the applications.
1.0 - initial release August 1992.


